
Physics Smörgåsbord of  
Sensor Experiments 

 

 
  
  
 
 

Fran Poodry 
physics@vernier.com 

 
NSTA National 2019 

St. Louis, MO 
 
 
 

INTRODUCTORY ACTIVITY 
 
 

Exploring Simple Harmonic Motion 
• Go Direct Sensor Cart 

 
 

EXPERIMENT STATIONS 
 
SHM 2 More Ways 
• Go Direct Force and Acceleration 
• Go Direct Motion 

 OR 
• Go Direct Force and Acceleration  

 

Sound Waves and Beats 
• Go Direct Sound 
• LabQuest 2 

 

Radioactivity 
• Go Direct Radiation Monitor 

 

Capacitors 
• Vernier Circuit Board 2 
• Go Direct Voltage Probe 

 

RLC Circuit 
• Power Amplifier 
• Go Direct Current Probe 
• Vernier Circuit Board 2 
• Go Direct Voltage Probe 
• LabQuest 2 

Emissions Spectra 
• Vernier Emissions Spectrometer 
• Spectrum Tube Single Power Supply 
• Helium Spectrum Tube 
• Hydrogen Spectrum Tube 
• Vernier Emissions Fiber 

 

Conservation of Angular Momentum 
• Go Direct Rotary Motion 
• Rotary Motion Accessory Kit 

 

Centripetal Acceleration/Moment of 
Inertia 
• Go Direct Force and Acceleration 
• Go Direct Centripetal Force Apparatus 

 

Magnetic Field of a Slinky 
• Go Direct 3-Axis Magnetic Field 
• EXTECH DC Power Supply 

 

Diffraction 
• Vernier Track 
• Diffraction Apparatus 
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 LabQuest 1 

α, β, and γ 
Nuclear radiation can be broadly classified into three categories. These three categories are 
labeled with the first three letters of the Greek alphabet: α (alpha), β (beta), and γ (gamma). 
Alpha radiation consists of a stream of fast-moving helium nuclei (two protons and two 
neutrons). As such, an alpha particle is relatively heavy and carries two positive electrical 
charges. Beta radiation consists of fast-moving electrons or positrons (an antimatter electron).  

A beta particle is much lighter than an alpha and carries one unit of charge. Gamma radiation 
consists of photons, which are massless and carry no charge. X-rays are also photons, but carry 
less energy than gammas. 

After being emitted from a decaying nucleus, the alpha, beta or gamma radiation may pass 
through matter, or it may be absorbed by the matter. You will arrange for the three classes of 
radiation to pass through nothing but a thin layer of air, a sheet of paper, and an aluminum sheet. 
Will the different types of radiation be absorbed differently by the air, paper and aluminum? The 
question can be answered by considering which radiation type will interact more strongly with 
matter, and then tested by experiment. 

In this experiment you will use small sources of alpha, beta, and gamma radiation. Follow all 
local procedures for handling radioactive materials. 

OBJECTIVES 
• Develop a model for the relative absorption of alpha, beta, and gamma radiation by matter. 
• Use a radiation counter to measure the absorption of alpha, beta, and gamma radiation by air, 

paper, and aluminum. 
• Analyze count rate data to test for consistency with your model. 

MATERIALS 
LabQuest 
LabQuest App 
Vernier Radiation Monitor 
paper sheet 
polonium-210 0.1µC alpha source  
strontium-90 0.1µC beta source 
cobalt-60 1µC gamma source 
aluminum sheet, about 2 mm thick 
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PRELIMINARY QUESTIONS 
1. Most nuclear radiation carries energy in the range of a few million electron volts, or MeV 

(1 MeV = 106 eV = 1.6 × 1013 J), regardless of its type (alpha, beta, or gamma). This means 
that more massive particles generally travel more slowly than light particles. Make a 
preliminary guess as to which radiation type will in general interact most strongly with 
matter, and therefore would be most strongly absorbed as it passes through matter. Consider 
electrical charge, mass and speed. Explain your reasons.  

2. Which radiation type do you predict would interact, in general, least strongly with matter, 
and so be less absorbed than others? Why? 

3. Which radiation type do you predict would have an intermediate level of interaction with 
matter? Why? 

4. You will be using paper and aluminum sheet metal as absorbers for the radiation. Which 
material has the greatest areal density (that is, a density measure in mass per unit area, which 
could be measured in g/cm2), and so would present more matter to the passing radiation? 
Which material would have less?  

5. Is your Radiation Monitor sensitive to all three types of radiation? How can you tell? Devise 
a test and carry it out.  

PROCEDURE 
1. Connect the Radiation Monitor to a DIG port of LabQuest. Choose New from the File menu.  

2. Set up the data-collection mode. 
a. On the Meter screen, tap Mode.  
b. Change the data-collection mode to Selected Events and select OK. 

3. Determine the background count rate.  
a. Move all sources away from the Radiation Monitor. 
b. Start data collection to prepare the system for data collection.  
c. Tap Keep. Counts are taken for 50 seconds.  

4. When the first point has been collected, place the beta source near the monitor screen of your 
Radiation Monitor, with the underside of the disc facing the monitor. Note: Place the 
Radiation Monitor and the source in approximately the same position each time you collect 
data. When using an absorber in later steps, place the absorber between the source and the 
monitor screen. Each time you collect data, the distance between the Radiation Monitor and 
the source should be approximately the same. 

5. Test the beta radiation source. 
a. Tap Keep. Counts are taken for 50 seconds. 
b. Place a single sheet of paper between the beta source and the monitor.  
c. Tap Keep.  
d. Place a single sheet of aluminum between the beta source and the monitor. 
e. Tap Keep.  

6. Stop data collection. 
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7. Tap the Table tab to view your data. Record the values in your data table. 

8. Tap the Meter tab and repeat Steps 4–7 with the alpha radiation source. 

9. Tap the Meter tab and repeat Steps 4–7 with the gamma radiation source. When you have 
completed the testing and recording your data, store the radiation sources as directed by your 
instructor. 

DATA TABLE 
Counts in 50 s interval 

  No shielding Paper shield Aluminum shield 

No source 
(background) 

      

Alpha source       

Beta source       

Gamma source       

ANALYSIS 
1. Compare the no-source, or background, count with the no-absorber counts for the sources. Is 

the background count number a significant fraction of the counts from the sources? Do you 
need to consider a correction for the background counts? 

2. Inspect your data. Does the count rate appear to follow your initial guesses for the relative 
absorption of the various types of radiation by matter? Be specific, considering which source 
should be the most penetrating (least interacting), and which absorber is more difficult to 
penetrate. 

3. X-rays are photons, just like gamma rays. X-rays carry lower energy, however, and so 
historically received a different name. If you have had an X-ray film picture of your teeth 
taken by a dentist, the dentist probably placed a lead-lined apron on your chest and lap before 
making the X-ray. What is the function of the lead apron? Support any assertion you make 
from your experimental data. 

EXTENSIONS 
1. If you were presented with a safe, but unknown, radiation source, and assuming that it 

emitted only one type of radiation, devise a test that would allow you to tentatively identify 
the type of radiation as primarily alpha, beta, or gamma. Write instructions for another 
student to follow in performing the test. 

2. Your monitor detected some radiation even without a source present. Devise a method to 
correct for this background radiation. Do the corrected data still agree with your prediction? 
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 LabQuest 2 

Distance and Radiation 
Scientists and health care workers using intense radiation sources are often told that the best 
protection is distance; that is, the best way to minimize exposure to radiation is to stay far away 
from the radiation source. Why is that?  

A physically small source of radiation, emitting equally in all directions, is known as a point 
source. By considering the way radiation leaves the source, you will develop a model for the 
intensity of radiation as a function of distance from the source. Your model may help explain 
why users of radiation sources can use distance to reduce their exposure.  

In this experiment you will use a small source of gamma radiation. Gamma rays are high-energy 
photons. If your source behaves as a point source, and if the air absorbs little or none of the 
gamma radiation, then the radiation intensity should be described well by your model. Follow all 
local procedures for handling radioactive materials. 

OBJECTIVES 
• Develop a model for the distance-dependence of gamma radiation emitted from a point 

source. 
• Use a counter to measure radiation emitted by a gamma source as a function of distance. 
• Analyze count rate data in several ways to test for consistency with the model. 

MATERIALS 
LabQuest 
LabQuest App 
Vernier Radiation Monitor 
cobalt-60 1µC gamma source 
meter stick 

PRELIMINARY QUESTIONS 
1. Place your cobalt-60 source on a table. Connect the Radiation Monitor to a DIG port on your 

interface and start the data-collection software if it doesn't start automatically. The LED on 
the Radiation Monitor flashes as the monitor detects radiation. The LED will flash more 
quickly when the monitor detects higher radiation level. Using this information and the 
cobalt-60 source, determine the most sensitive place on the detector. That is, roughly where 
inside the monitor case is the radiation being detected? 

2. Starting about a meter from your source, slowly move the monitor closer to the source until 
they nearly touch. How does the flash rate vary with distance from the source? Would you 
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say that the flash rate is proportional to distance from the source? Or is it an inverse 
relationship?  

3. Sketch a qualitative graph of the flash rate vs. distance from the source. 

4. Suppose a small radiation source (a point source) is placed at the center of two spheres. The 
spheres are transparent to the radiation. One sphere has a radius r, and the other a radius 2r. 
N particles leave the source each second and travel outward toward the spheres. How does 
the number of particles passing through the inner sphere per unit area compare to the number 
per unit area passing through the outer sphere? Solve this problem by considering the 
following: 
a. How many total particles pass through the first sphere? How many pass through the 

second sphere? 
b. How do the surface areas of the two spheres compare? 

5. From your answer to the previous question, write down an expression for the intensity of 
radiation (number of particles passing through a unit area each second) as a function of 
distance from a point source. Assume that N particles leave the source each second. This 
expression is your model for the way radiation intensity varies with distance. Record your 
model in the data table. 

6. Is your model consistent with the qualitative sketch you drew in Preliminary Question 3? 

PROCEDURE 
1. Connect the Radiation Monitor to a DIG port of LabQuest if it isn't already connected. 

Choose New from the File menu.  

2. Set up the data-collection mode. 
a. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. 
b. Change the Count Interval to 300 seconds. 
c. Select OK. 

3. When your source is far from the Radiation Monitor, the monitor still detects background 
counts from cosmic rays and other sources. You will need to correct for this background by 
determining the average count rate with no source near the monitor. Determine the 
background count rate.  
a. Move all sources away from the monitor. 
b. Start data collection to prepare the system for data collection.  
c. Tap Keep. Counts are taken for 300 seconds.  
d. Enter 0 to indicate that this is the value for the background count. Select OK. 
e. Stop data collection.  
f. Record the average background counts per minute in your data table. 

4. Set up the data-collection mode. 
a. Tap the Meter tab.  
b. On the Meter screen, tap Mode.  
c. Change the Count Interval to 60 seconds. 
d. Enter the Name (Distance) and the Units (m).  
e. Select OK. 
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5. Place the center of the source 6 cm from the monitor screen of the Radiation Monitor. 

6. Start data collection. Tap Keep. The number of gamma photons that strike the detector will 
be counted during the 60-second data collection period.  

7. After 60 seconds have elapsed, enter 0.06, the distance in meters from the detector to the 
center of the source. Save this data pair by selecting OK. 

8. Move the source 0.02 m farther from the source. Tap Keep to count for the new distance. 
When the data collection period is complete, enter the new distance of 0.08 m and select OK. 

9. In the same way as before, move the source an additional 0.02 m out, tap Keep, and wait for 
counting to complete. Enter the new distance in meters. Repeat this process until the distance 
is at least 0.24 m or the rate drops below 10 counts per minute. 

10. Stop data collection. 

11. Correct the data for background radiation. 
a. Tap the Table tab.  
b. Choose New Calculated Column from the Table menu.  
c. Enter Corrected count as the Name and cpm as the Units.  
d. Select X-A as the Equation.  
e. Enter the average background radiation count from Step 3 as the value for A.  
f. Select OK to view a graph of corrected counts vs. distance. 

DATA TABLE 
Model expression   

Average background counts   

Fit parameters and equation   

ANALYSIS 
1. Inspect your graph. Does the count rate appear to follow your model?  

2.  Fit an appropriate function to your data.  
a. On the Graph screen, choose Curve Fit from the Analyze menu. 
b. Choose the equation that matches the mathematical form of your model as the Fit 

Equation. 
c. Record the fit equation and parameters in your data table. 
d. Select OK.  

3. Print or sketch your graph.  

4. From the evidence presented in your two graphs, does the gamma radiation emitted by your 
source follow your model? Does the relationship seem to fail at larger or smaller distances? 
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EXTENSIONS 
1. Replot your data using a suitable transformation of the x-coordinate so that the resulting plot 

should be linear if the data follow your model. For example, if your model were an inverse-
cube function, replot the data using the inverse-cube of the distance values for the horizontal 
axis. Do your data follow the model well using this test? 

2. Why were you instructed to place the source no closer than 0.06 m from the detector? Repeat 
the experiment, using distances of 0, 0.02, 0.04… out to 0.24 m. Hint: Is the detector a 
spherical surface?  

3. Use a longer counting interval so that you collect at least 300 counts at 0.06 m. Is the 
agreement with the inverse-square relationship any different? Try a much shorter count 
interval. How is the resulting graph different? Why? 

4. Sometimes the table surface can scatter gamma rays, interfering with data collection. Use a 
ring stand or other support to hold the sample above the monitor, so that there are no surfaces 
near the source. Repeat data collection. Do your data agree any better with your model? 

5. Instead of using one of the built-in curve fits for your data, choose Model from the Analyze 
menu to superimpose an equation with exactly the same form as your model on your data. 
Does this equation fit your data? Is this a better test of your model? Why? 
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Conservation of  
Angular Momentum 

INTRODUCTION 
In your study of linear momentum, you learned that, in the absence of an unbalanced external 
force, the momentum of a system remains constant. In this experiment, you will examine how the 
angular momentum of a rotating system responds to changes in the moment of inertia, I. 

OBJECTIVES 
In this experiment, you will 

• Collect angle vs. time and angular velocity vs. time data for rotating systems. 
• Analyze the θ-t and ω-t graphs both before and after changes in the moment of inertia. 
• Determine the effect of changes in the moment of inertia on the angular momentum of the 

system.  
 

MATERIALS 
Vernier data-collection interface ring stand or vertical support rod 
Logger Pro or LabQuest App balance 
Vernier Rotary Motion Sensor metric ruler 
Vernier Rotary Motion Accessory Kit  

 
 
PROCEDURE 
1. Mount the Rotary Motion Sensor to the vertical support rod. Place the 3-step Pulley on the 

rotating shaft of the sensor so that the largest pulley is on top. Measure the mass and diameter 
of the aluminum disk with the smaller hole. Mount this disk to the pulley using the longer 
machine screw sleeve (see Figure 1). 

 
Figure 1 



Experiment 14 

2 Advanced Physics with Vernier - Mechanics 

2. Connect the sensor to the data-collection interface and begin the 
data-collection program. The default data-collections settings are 
appropriate for this experiment.  

3. Spin the aluminum disk so that it is rotating reasonably rapidly, then 
begin data collection. Note that the angular velocity gradually 
decreases during the interval in which you collected data. Consider 
why this occurs. Store this run (Run 1). 

4. Obtain the second aluminum disk from the accessory kit; determine 
its mass and diameter. Position this disk (cork pads down) over the 
sleeve of the screw holding the first disk to the pulley. Practice 
dropping the second disk onto the first so as to minimize any torque 
you might apply to the system (see Figure 2). 

5. Begin the first disk rotating rapidly as before and begin collecting 
data. After a few seconds, drop the second disk onto the rotating 
disk and observe the change in both the θ-t and ω-t graphs. Store 
this run (Run 2). 

6. Repeat Step 5, but begin with a lower angular velocity than before. 
Store this run (Run 3). 

7. Find the mass of the steel disk. Measure the diameter of both the 
central hole and the entire disk. Replace the first aluminum disk with 
the steel disk and hub and tighten the screw as before (see Figure 3). 

8. Try to spin the steel disk about as rapidly as you did the aluminum 
disk in Step 3 and then begin collecting data. Store this run (Run 4).  

9. Repeat Step 5, dropping the aluminum disk onto the steel disk after 
a few seconds. Store this run (Run 5) and save the experiment file in 
case you need to return to it. 

 
EVALUATION OF DATA  
1. Use a text or web resource to find an expression for the moment of inertia for a disk; 

determine the values of I for your aluminum disks. With its large central hole, the steel disk 
should be treated as a cylindrical tube. Using the appropriate expression, determine the value 
of I for the steel disk.  

2. Examine the ω-t graph for your runs with the single aluminum disk (Run1) and the steel disk 
(Run 4). Determine the rate of change of the angular velocity, ω, for each disk as it slowed. 
Account for this change in terms of any unbalanced forces that may be acting on the system. 
Explain the difference in the rates of change of ω (aluminum vs. steel) in terms of the values 
you calculated in Step 1. 

Figure 2 

Figure 3 
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3. Examine the ω-t graph for Run 2. Determine the rate of change of ω before you dropped the 
second disk onto the first. Record the angular velocity just before and just after you increased 
the mass of the system. Determine the time interval (∆t) between these two velocity readings. 

• In Logger Pro, drag-select the interval between these two readings. The ∆x in the lower 
left corner gives the value of ∆t. 

• In LabQuest App, drag and select the interval between these two readings and use the 
Delta function under Statistics to perform this task. 

4. The angular momentum, L, of a system undergoing rotation is the product of its moment of 
inertia, I, and the angular velocity, ω. 

 

L = Iω  
 Determine the angular momentum of the system before and after you dropped the second 

aluminum disk onto the first. Calculate the percent difference between these values. 

5. Use the initial rate of change in ω and the time interval between your two readings to 
determine ∆ω due to friction alone. What portion of the difference in the angular momentum 
before and after you increased the mass can be accounted for by frictional losses?  

6.  Repeat the calculations in Steps 3–5 for your third and fifth runs. 

 
EXTENSION 
In this experiment, the moment of inertia of the rotating system was changed by adding mass. In 
what other way could one change the moment of inertia? Consider an example of how this is done 
outside the lab. Explain how this change in I produces a change in ω . 
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Centripetal Acceleration 
INTRODUCTION 
The typical response when one hears the word acceleration is to think of an object changing its 
speed. You have also learned that velocity has both magnitude and direction. So, an object 
traveling at constant speed in a circular path is undergoing an acceleration. In this experiment you 
will develop an expression for this type of acceleration.  

 
OBJECTIVES 
In this experiment, you will 

• Analyze velocity vectors of an object undergoing uniform circular motion to determine the 
direction of the acceleration vector at any given moment. 

• Collect force, velocity, and radius data for a mass undergoing uniform circular motion.  
• Analyze the force vs. velocity, force vs. mass, and force vs. radius graphs. 
• Determine the relationship between force, mass, velocity, and radius for an object 

undergoing uniform circular motion. 
• Use this relationship and Newton’s second law to determine an expression for centripetal 

acceleration. 
 
 
MATERIALS 

LabQuest  Vernier Centripetal Force Apparatus 
Vernier Photogate  masses 
Vernier Dual-Range Force Sensor   

 
 
PRE-LAB INVESTIGATION 
Tie something soft (such as a stopper) to a one-meter length of string. Taking care not to hit 
anyone nearby, swing the stopper so that it travels in a horizontal circular path over your head. 
Feel the tension force you must apply in order to keep the stopper moving at a nearly constant 
speed. Now, see what effect varying the speed of the stopper or the length of the string has on the 
force you apply to keep the stopper moving in a circular path. Record your observations. 

Your instructor will lead a discussion that will enable you to determine the direction of the 
acceleration vector for an object moving at constant speed in a circular path. For this experiment, 
you will use an apparatus that will allow you to measure the force acting on an object undergoing 
circular motion that is more uniform than you could achieve by swinging it. 

 
PART 1 – FORCE VS. VELOCITY  
PROCEDURE 
1. Attach a Dual-Range Force Sensor and a Vernier Photogate to the Vernier Centripetal Force 

Apparatus (CFA), as shown in Figure 1.  
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Figure 1 

2. Connect the force sensor and the photogate to LabQuest. 

3. Set up data collection. 
a. Tap Mode. The default Photogate Mode►Motion works for this experiment. Select 

the User defined button. The distance to be entered is 1/10 of the circumference of the 
mass path. Because the radius in part 1 is 10 cm, this value should be 0.0628 m. 

b. To control when data collection stops, tap the option labeled “with the Stop button” in 
the field labeled “End data collection.” Tap OK. 

c. From the Graph menu select Graph 1. Change the axes of the graph so that it shows 
force vs. velocity. 

d. Tap the Meter tab. 
 
4. Determine the mass of the sliding mass carriage. Add mass to both the sliding and fixed mass 

carriages as directed by your instructor. The mass of the sliding and fixed carriages should be 
the same so that the beam is balanced. Record the total mass of the sliding carriage and extra 
mass. 

5. Position the fixed carriage so that its center is 10 cm from the axis of rotation. Adjust the 
position of the force sensor on the rail so that, when the line is taut, the center of the sliding 
mass carriage is also at 10 cm.  

6. Zero the force sensor.  

7. Spin the beam by twisting the knurled spindle of the CFA with your fingers. When the force 
reaches 5–8 N, begin collecting data. Let data collection continue for 20-40 s. When you stop 
data collection, use the friction between your hand and the knurled spindle to stop the beam.  
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EVALUATION OF DATA  
1. Examine your graph. Write a statement that describes the relationship between the force 

acting on the carriage and its tangential velocity. 

2. If your graph of force vs. velocity is not linear, create a calculated column that will enable you 
to obtain a linear relationship.  

3. From the Graph menu select Graph 1. Set the graph up to show the linearized plot.  

4. Write the equation of the line that best fits your linearized graph. Determine the units of the 
slope; simplify these as much as possible. Save your LabQuest App file. 

5. Compare the value of the slope of the linearized graph with that obtained by other groups in 
your class. Speculate about what might be responsible for any differences in the slopes.  

 
PART 2 – INVESTIGATING THE EFFECT OF MASS AND RADIUS 
When a quantity (in this case, force) is a function of more than one variable, it is usually the case 
that the slope of the graph is related to the parameters held constant during the experiment. 
Examine the units of the slope of your graph of F vs. v2. Write an expression involving mass and 
radius that has the same units as that of your slope. Substitute the known values of these 
parameters; how closely does the value of this expression agree with that of your slope? Predict 
the effect of doubling the mass on the value of the slope. What effect would doubling the radius 
have on the slope? You can test your conclusions by varying first the mass and then the radius as 
follows. 

 
PROCEDURE 
1. Change the mass on both the fixed and sliding carriages and record the value of the total mass 

of the sliding carriage and any extra masses. 

2. Re-zero the force sensor, then spin the beam as you did before. Once the force reaches  
5–8 N, begin collecting data. When you stop data collection, stop the beam as you did in 
Part 1.  

3. Perform a linear fit to the data on the F vs. v2. Record the value of the slope for the fit. 

4. Change the system mass again and record the value of the total mass of the sliding carriage 
and any extra masses, then repeat Step 2 and 3.  

5. Return the mass on both the fixed and sliding carriages to the original value used in Part 1. 
Decrease the radius of both the sliding and fixed mass carriage by 2-3 cm. Record the value of 
the radius. Adjust the value of the User defined distance in the Mode window so that it is 1/10 
of the circular path of the mass carriage. A warning will appear. Choose to discard the data. 

6. Re-zero the force sensor, then spin the beam as you did before. Once the force reaches  
5–8 N, begin collecting data. When you stop data collection, stop the beam. 

7. Set up Graph 1 to be a plot of F vs. v2. Perform a linear fit to the data. Record the value of the 
slope for the fit. 
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8. Now, change the radius so that it is 2–3 cm greater than your initial value. Be sure to adjust 
the User defined distance as you did in Step 5. Record the value of the radius, then repeat 
Step 6 and 7. 

 
EVALUATION OF DATA  
1. Examine the value of the slope of each of the first three runs. What relationship appears to 

exist between the value of the slope and the total mass of the sliding carriage? 

2. To study the effect of changing the radius, select one of the runs in which you changed the 
radius from its original value of 0.10 m. 

3. Compare the value of the slope for this run to that for your first run (r = 0.10 m). 

4. Repeat Steps 2 and 3 for another run in which you changed the radius. Does the change in the 
radius have the expected effect on the value of the slope? Compare your findings with those of 
other groups in class. 

6. Write an equation relating the net force, mass, radius and velocity of a system undergoing 
circular motion. 

7. Use what you have learned in Steps 1–5 and Newton’s second law to write an equation for 
the acceleration of the object undergoing circular motion. Use your text or a web resource to 
determine the meaning of the term “centripetal.” 

 
EXTENSION 
Wikipedia warns that the centripetal force is not to be confused with centrifugal force. It describes 
the latter as a fictitious or inertial force. Describe an example of such a force that you have 
experienced and how this interaction might better be explained in terms of centripetal force.  
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Capacitors 
The charge q on a capacitor’s plate is proportional to the potential difference V across the 
capacitor. We express this relationship with  

 

where C is a proportionality constant known as the capacitance. The unit used for capacitance is 
the farad, F (1 farad = 1 coulomb/volt).  

If a capacitor of capacitance C (in farads), initially charged to a potential V0 (in volts) is connected 
across a resistor R (in ohms), a time-dependent current will flow according to Ohm’s law. This 
situation is shown by the RC (resistor-capacitor) circuit below when the switch is connecting 
terminals 33 and 34. 

  

Figure 1    
As the charge flows, the charge q on the capacitor is depleted, reducing the potential across the 
capacitor, which in turn reduces the current. This process creates an exponentially decreasing 
current, modeled by  

 

The rate of the decrease is determined by the product RC, known as the time constant of the 
circuit. A large time constant means that the capacitor will discharge slowly.  

OBJECTIVES 
• Experimentally determine the time constant of a resistor-capacitor circuit. 
• Compare the time constant to the value predicted from the component values of the 

resistance and capacitance.  
• Measure the potential across a capacitor as a function of time as it discharges. 
• Fit an exponential function to the data. One of the fit parameters corresponds to an 

experimental time constant. 
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MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct Voltage 
connecting wires with clips 
Vernier Circuit Board 2 with batteries or  
   10 μF non-polarized capacitor 
   100 kΩ and 47 kΩ resistors 
   two C- or D-cell batteries with holder 
   single-pole, double-throw switch 

PRELIMINARY QUESTIONS 
1. Consider a candy jar, initially with 1000 candies. You walk past it once each hour. Since you 

do not want anyone to notice that you are taking candy, each time you take only 10% of the 
candies remaining in the jar. Sketch a graph of the number of candies for a few hours.  

2. How would the graph change if instead of removing 10% of the candies, you removed 20%? 
Sketch your new graph.  

PROCEDURE 
1. Set up the equipment. 

a. Connect the circuit using the 10 μF capacitor and the 100 kΩ resistor, as shown in 
Figure 1. Note: The numbers in the figure refer to the numbered terminals on the Vernier 
Circuit Board. 

b. Record the values of your resistor and capacitor in your data table, as well as any tolerance 
values marked on them. 

c. Launch Graphical Analysis. Connect the Go Direct Voltage Probe to your Chromebook, 
computer, or mobile device. 

d.  Connect the clip leads on the voltage probe across the capacitor. Note: Connect the red 
lead to the side of the capacitor connected to the resistor. Connect the black lead to the 
other side of the capacitor. 

e. Set Switch 1, SW1, located below the battery holder on the Vernier Circuit Board, to 
3.0 V. 

2. Monitor the input to determine the maximum voltage your battery produces. 

a. Set Switch 2, SW2, to charge the capacitor for 10 seconds (so the switch is closer to 
terminal 32). 

b. Watch the reading on the screen and record the maximum value reached. You will use this 
value in the next step. 
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3. Set up Graphical Analysis for triggering and data collection. In this mode you will not have to 
manually synchronize data collection and the capacitor discharge. Instead, Graphical Analysis 
will wait for the voltage to reach a certain level before collecting data. 

a. Click or tap Mode to open Data Collection Settings.  
b. Change Rate to 200 samples/s and End Collection to 4 s. Click or tap Done. 
c. Change Start Collection to start data collection on a triggering event rather than manually.  
d. Then, adjust the triggering settings so that data collection starts when voltage is 

decreasing. Enter a trigger level of 90% of the maximum voltage you observed in Step 2. 
This means that data collection will begin when voltage decreases across this trigger level. 

e. Use 0 as the number of points collected before data collection is triggered. 
f. Click or tap Done. 

4. Collect data. 

a. Click or tap Collect to start data collection. 
b. Flip Switch 2 to discharge the capacitor. 
c. Graphical Analysis waits for the measured voltage to reach the trigger level before 

collecting data. After data collection is complete, a graph of voltage vs. time is displayed. 
5. Fit the exponential function, y = a•exp(–cx) + b, to your data.  

a. Click or tap Graph Tools, , and choose Apply Curve Fit. 
b. Select Natural Exponent as the curve fit and click or tap Apply. 
c. Record the value of the fit parameters in your data table. Notice that the c used in the curve 

fit is not the same as the C representing capacitance. Compare the fit equation to the 
mathematical model for a capacitor discharge proposed in the introduction. 

 
How is fit constant c related to the time constant of the circuit, which was defined in the 
introduction? 

6. Export, print, or sketch the graph of voltage vs. time. 

7. Replace the 100 kΩ resistor with a 47 kΩ resistor in the circuit and repeat Steps 2–6. 

DATA TABLE 

 Fit parameters Resistor Capacitor Time 
constant 

Trial a b c 1/c R 
(Ω) 

C 
(F) 

RC 
(s) 

Discharge 1               

Discharge 2               
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ANALYSIS 
1. In the data table, calculate the time constant of the circuit used; that is, the product of 

resistance in ohms and capacitance in farads. Note: 1Ω•F = 1 s 

2. Calculate and enter in the data table the inverse of the fit constant c for each trial. Now 
compare each of these values to the time constant of your circuit. How is the fit parameter a 
related to your experiment? 

3. Resistors and capacitors are not marked with their exact values, but only approximate values 
with a tolerance. Determine the tolerance of the resistors and capacitors you are using. If there 
is a discrepancy between the two quantities compared in Question 2, can the tolerance values 
explain the difference? 

4. What was the effect of reducing the resistance of the resistor on the way the capacitor 
discharged?  

EXTENSIONS 
1. What fraction of the initial potential remains after one time constant has passed? After two 

time constants? Three? 

2. Instead of a resistor, use a small flashlight bulb. To light the bulb for a perceptible time, use a 
large capacitor (approximately 1 F). Collect data. Explain the shape of the graph. 

3. Try different value resistors and capacitors and see how the capacitor discharge curves change. 

4. Try two 10 μF capacitors in parallel. Predict what happens to the time constant. Repeat the 
discharge measurement and determine the time constant of the new circuit using a curve fit. 

5. Try two 10 µF capacitors in series. Predict what will happen to the time constant. Repeat the 
discharge measurement and determine the time constant for the new circuit using a curve fit. 

6. Make a plot of ln(V) vs. time for the capacitor discharge. What is the meaning of the slope of 
this plot? How is it related to the RC constant? 
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RLC Circuits 
INTRODUCTION 
You have studied the behavior of capacitors and inductors in simple direct-current (DC) circuits. 
In alternating current (AC) circuits, these elements act somewhat like resistors to limit current 
flow. The term used for the resistance these elements offer to current flow in AC circuits is 
reactance. The general term for the sum of all the resistance and reactance (both capacitive and 
inductive) in a circuit is impedance.  

The reactance for a particular capacitor or inductor varies with the frequency of the circuit. 
Capacitors store energy in electric fields. When fully charged, they will not let current flow in a 
DC circuit. However, in AC circuits, as the frequency increases, their resistance to the flow of 
charge decreases. Inductors store energy in magnetic fields. In DC circuits, an ideal inductor has 
no resistance, but in AC circuits, its resistance increases with the frequency. 

In this experiment, you will examine the behavior of an AC circuit containing a capacitor (C), an 
AC circuit containing a resistor and an inductor (RL), and an AC circuit containing all three 
elements (RLC). 

 
OBJECTIVES 
In this experiment, you will 

• Learn the terms capacitive reactance, inductive reactance, and impedance.  
• Determine the relationship between the reactance and frequency for a capacitor.  
• Determine the relationship between the impedance and frequency of an RL circuit. 
• Determine the resonant frequency of an RLC circuit. 
• Experiment with resonance and energy transfer in an RLC circuit. 

 
 
MATERIALS 

Vernier LabQuest or  powdered iron core1 
   LabPro or LabQuest Mini and a computer Vernier Inductor (5 mH) 
   with audio output and Vernier Power Vernier Circuit Board or  
   Amplifier computer program2    mini lamp (2.0V, #48, cylindrical)  
Logger Pro or LabQuest App    mini lamp holder 
Vernier Power Amplifier    clip leads 
Vernier Differential Voltage Probe    10 Ω resistor 
Vernier Current Probe    10 µF capacitor (non polarized) 

 
 

                                                
1 You could also use a number of painted nails taped together in place of this core. 
2 The Vernier Power Amplifier computer program can be downloaded from www.vernier.com/downloads. 
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PRE-LAB INVESTIGATION 
Consider the circuit in Figure 1.  

  
Figure 1 

What would the Current Probe read soon after you connected the leads to the battery? Why? 
Suppose you were able to connect the leads to the battery momentarily, disconnect them, then flip 
the battery, reconnect the leads, and repeat the process a number of times. What effect would this 
have on the current in the circuit? Why? 

If the capacitor were replaced by an inductor and the leads were connected to the battery, how 
would the current vary over time? Why? Suppose that you repeated the same battery flip process 
described above. What effect would this have on the current in the circuit? Why? 

In your class discussion, make sure you can explain the difference in the behavior of the circuits 
when the direction of the flow of charge is unchanged and when it changes rapidly. 

 
PART 1  A CAPACITOR IN A CIRCUIT 
PROCEDURE 
1. Set up the circuit with a 10 µF capacitor in series with a current probe, as shown in Figures 2 

and 3. The Voltage Probe will measure the potential difference across the capacitor plates. 

 
   Figure 2       Figure 3 
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2. Choose one of the following options to drive the Power Amplifier. 
LabQuest with Logger Pro 
a. Use the mini stereo cable that came with the amplifier to connect the Speaker Out port on 

LabQuest and the Audio In port on the amplifier. 
b. In Logger Pro, choose Set Up Sensors ► Show All Interfaces from the Experiment menu.  
c. From the Sensor Setup dialog box, click Power Amplifier. In the Waveform list, click Sine. 
d. The default value of 2.0 V is suitable, but change the initial frequency to 100 Hz. Use the 

up and down arrows to adjust the frequency, or use the parameter box to enter the desired 
value. 

e. Click Start. 
 

LabQuest as a standalone device 
a. Use the mini stereo cable that came with the amplifier to connect the Speaker Out port on 

LabQuest and the Audio In port on the amplifier. 
b. Launch Power Amplifier from the Home screen. The default setting of 2.0 VAC is suitable, 

but reduce the frequency to 100 Hz.  
c. Tap Start. Use the up and down arrows to adjust the frequency or enter the value in the 

parameter field. 
 

Power Amplifier computer program and the computer’s audio output 
Use this option if using LabQuest Mini or LabPro for data collection. 
a. Use the mini stereo cable that came with the Power Amplifier to connect the Speaker Out 

port on your computer and the Audio In port on the amplifier. 
b. Set the computer’s sound output on and at maximum volume.  
c. Start the Vernier Power Amplifier computer program. 
d. The default value of 2.0 V is suitable, but set the initial frequency to 100 Hz. To adjust the 

frequency, use the up and down arrows, or use in the parameter box to enter the desired 
value. 

e. Click Start. 
 
3. Connect the voltage and current probes to the interface and start the data-collection program. 

Two graphs, potential vs. time and current vs. time, will be displayed. Change the data-
collection rate to 10,000 samples/second and the duration to 0.02 seconds. 

4. Start the power amplifier output using a sine wave output with the frequency set to 100 Hz 
and an amplitude of 2.0 volts. Close the switch to complete the circuit. 

5. From your Pre-Lab Investigation, consider how the circuit you have constructed should 
behave. Now that you have connected this circuit to an AC voltage source, would you expect 
the current to be greater at low or high frequencies? 

6. To test your prediction, start data collection. When data collection stops, choose Statistics 
from the Analyze menu to determine the maximum value of the potential and the current for 
the run; record these values in your notebook. 

7. Continue collecting data in this way until you have potential and current values for  
6–7 frequencies ranging up to 1000 Hz.  
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EVALUATION OF DATA 
1. For each of your runs, the maximum voltage should have remained roughly the same. How 

did the maximum current in the circuit vary with frequency? Write a statement that describes 
the relationship you found. 

2. For each frequency, determine the capacitive reactance (Xc) of the capacitor by dividing the 
maximum value of the potential by the maximum value of the current. From what you know 
about Ohm’s law, determine the units of capacitive reactance. 

3. Disconnect the probes from the interface and choose New from the File menu. In the table, 
manually enter values so as to produce a graph of capacitive reactance vs. frequency. Instead 
of Hz, use 1/s as the units for frequency. Write a statement that describes the relationship 
between the capacitive reactance and frequency. 

4. If your graph of capacitive reactance vs. frequency is not linear, take steps to modify a column 
so as to produce a linear relationship. When you have done so, save your file and (if possible) 
print a copy of your original and then linearized graph.  

5. Write the equation of the line that best fits your linearized graph. Examine the units of the 
slope of the line.  

6. The textbook definition of capacitive reactance is 

 Rearrange this equation so that it has the same form as the one you recorded in Step 5. 
Compare the slope (value and units) of the equation for your linearized graph to the constant 
of proportionality in this equation. From the units for f and C, show that the unit of capacitive 
reactance is the ohm. 

7. Many capacitors have a tolerance of 10%. This means that their capacitance is only 
guaranteed to be within 10% of their labeled value. Would your data indicate that your 
capacitor is within its specification? 

 

( )CfX c ⋅= π21
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PART 2  AN RL CIRCUIT 
PROCEDURE  
1. Set up the circuit with a 10 Ω resistor in series with a current probe and a 5.0 mH inductor. as 

shown in Figures 4 and 5.  

 
   Figure 4               Figure 5 
 
2. Connect the voltage and current probes to the interface and start the data-collection program. 

Change the data-collection rate to 10,000 samples/second and the duration to 0.02 seconds. 

3. Start the power amplifier output using a sine wave output with the frequency set to 100 Hz 
and an amplitude of 2.0 volts.  

4. From your Pre-Lab Investigation, consider how the circuit you have constructed should 
behave. Now that you have connected this circuit to an AC voltage source, would you expect 
the current to be greater at low or high frequencies?  

5. Close the switch and begin collecting data. When data collection stops, use the Statistics tool 
to determine the maximum value of the potential and the current for the run; record these 
values in your notebook. 

6. Continue collecting data in this way until you have potential and current values for  
6–7 frequencies ranging up to 1000 Hz. 

 
EVALUATION OF DATA 
1. For each of your runs, the maximum voltage should have remained roughly the same. How 

did the maximum current in the circuit vary with frequency? Write a statement that describes 
the relationship you found. 

2. Impedance is the general term for the opposition to the current due to the resistance and 
reactance of circuit elements. In this step, you will determine how the impedance varies with 
the frequency. For each frequency, determine the value and units of the impedance of the 
circuit by dividing the maximum value of the potential by the maximum value of the current.  
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3. Disconnect the probes from the interface and choose New from the File menu. In the table, 
manually enter values so as to produce a graph of impedance vs. frequency. Instead of Hz, use 
1/s as the units for frequency.  

4. At first glance, the relationship between impedance and frequency might appear to be linear. 
Closer inspection shows that this is not the case. Rather than performing a curve fit on the 
data, take steps to modify one of the variables so as to produce a more linear graph. You may 
find it necessary to modify the variables on both axes to achieve this end. When you have a 
linear graph, record the equation of the best-fit line. 

5. Relate the y-intercept of your graph to the resistance of the circuit; be sure to include the 
resistance of the inductor.  

6. The textbook definition of inductive reactance is . Relate this equation to the 
equation of your best-fit line. What does the slope of your equation indicate about your 
inductor? 

 
PART 3  AN RLC CIRCUIT 
PROCEDURE  
1. Set up the circuit as shown in Figure 6. This is an RLC circuit, containing a capacitor, an 

inductor, a current probe, and a mini lamp, which serves as the resistor. 

 
Figure 6 

2. Connect the current probe to the interface and start the data-collection program. Change the 
data-collection rate to 10,000 samples/second and the duration to 0.02 seconds. 

3. Start the power amplifier output using a sine wave output with the frequency set to 100 Hz; 
increase the amplitude to 5.0 volts. Close the switch to complete the circuit. 

4. Collect data and, as you have done before, determine the maximum current. Record this value 
in your lab notebook. 

5 Repeat Step 4 until you have data for at least eight frequencies ranging up to 1300 Hz. 

6. Disconnect the probe from the interface and choose New from the File menu. In the table, 
manually enter values so as to produce a graph of current vs. frequency. Examine your graph 
and determine the frequency at which the current in your circuit was greatest. 
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7. Use the frequency controls of the program you used to control the power amplifier to try 
different frequencies while watching the lamp. Focus your investigation in the region where 
the current was highest. Find the frequency that causes the lamp to glow most brightly. This is 
the resonant frequency of your RLC circuit. 

8. Once you have determined the resonant frequency of your circuit, place the powdered iron 
core inside the coil of your inductor. Note the effect this has on the brightness of the bulb. 
Check to see if the resonance frequency has changed. 

 
EVALUATION OF DATA 
1. An RLC circuit can be considered to be analogous to a damped spring/mass combination 

moving in simple harmonic motion. Like the spring/mass combination, it has a resonant 
frequency at which it absorbs outside energy most readily. In this part of the experiment, you 
found this resonant frequency for your RLC circuit. Resonance occurs when the impedance of 
the circuit is a minimum. For RLC circuits, impedance is defined as 

 

The value of impedance reaches a minimum when the inductive reactance and the capacitive 
reactance are equal. Using the equations for capacitive and inductive reactance, derive an 
equation to calculate the resonant frequency for an RLC circuit. 

2. Using the labeled values for the capacitor and inductor you used, calculate the expected 
resonant frequency for your circuit. 

3. How does your measured resonant frequency compare with the calculated value? What 
factors could explain any difference? 

4. Can you explain the change in the bulb brightness when you placed the metal core into the coil 
of the inductor? 

 
EXTENSIONS 
1. Consider the RLC circuit below. 

 

 The low-voltage AC power supply powering the circuit can change frequencies over a wide 
range. At a particular frequency, lamps A and B are equally bright. What happens to the 
brightness of the lamps if you increase the frequency? Explain. 
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2. To the circuit and software setup from Part 3 (the RLC circuit with the lamp), add the voltage 
probe connected across the terminals of the power amplifier. This will enable you to study the 
phase relationship between the current and voltage waveforms. Since both current and voltage 
are graphed using the same time scale, you can easily see how the two compare over time. 
Here are some questions to investigate:  
a. Begin with the resonant frequency. Describe the phase relationship between the current and 

voltage waveforms. 
b. Decrease the frequency by a few hundred hertz. Describe the phase relationship between 

the current and voltage waveforms. If they are not in phase, is the current peak leading or 
following the voltage peak; i.e., which occurs first? 

c. Repeat Step b with a frequency a few hundred hertz above the resonant frequency. 
Describe the phase relationship between the current and voltage waveforms. 

 
3. How can you best determine the inductance? Calculate the inductance of your coil with a 

metal core added. 
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The Magnetic Field in a Slinky 
A solenoid is made by wrapping a tube with many turns of wire. A metal Slinky is the same 
shape and will serve as a solenoid. When a current passes through the wire, a magnetic field is 
present inside the solenoid. Solenoids are used in electronic circuits or as electromagnets.  

In this lab you will explore factors that affect the magnetic field inside the solenoid and study how 
the field varies in different parts of the solenoid. By inserting a magnetic field sensor between the 
coils of the Slinky, you can measure the magnetic field inside the coil. You will also measure μ0, 
the permeability constant. The permeability constant is a fundamental constant of physics. 

 

Figure 1    

OBJECTIVES 
• Determine the relationship between magnetic field and the current in a solenoid. 
• Determine the relationship between magnetic field and the number of turns per meter in a 

solenoid. 
• Study how the field varies inside and outside a solenoid. 
• Determine the value of μ0, the permeability constant. 

MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct 3-Axis Magnetic Field  
Extech Digital DC Power Supply 
metal Slinky 
meter stick 
masking tape 
connecting wires with clips 
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INITIAL SETUP 
1. Set up the sensor. 

a. Launch Graphical Analysis. 
b. Connect the Go Direct 3-Axis Magnetic Field Sensor to your Chromebook, computer, or 

mobile device.  
c. Click or tap Sensor Channels. 
d. Enable the Y magnetic field channel and disable the X magnetic field channel.  
e. Click or tap Done. 

2. Set up the data-collection mode. 

a. Click or tap Mode to open Data Collection Settings. Change Mode to Event Based. 
b. Enter Current as the Event Name and A as the Units.  
c. Click or tap Done. 

3. Stretch the Slinky until it is about 1 m long. The spacing between the coils should be 1–2 cm. 
Use a non-conducting material such as masking tape to hold the Slinky at this length. 

4. Set up the circuit and equipment as shown in Figure 1. 

5.  Turn on the power supply, and adjust it so that the current is 2.0 A. 

PRELIMINARY QUESTIONS 
1. Hold the magnetic field sensor between the turns of the Slinky 

with the y-axis label at the center of the coil (see Figure 2). 
Rotate the sensor and determine which direction gives the largest 
positive magnetic field reading. What direction is the y-axis label 
on the tip of the sensor pointing? 

2. What happens if you rotate the sensor so the y-axis label on the 
tip points the opposite way? What happens if you rotate the 
sensor so the y-axis label of the sensor is perpendicular to the axis 
of the solenoid? 

3. Insert the magnetic field sensor through different locations along the Slinky to explore how the 
field varies along the length. Always orient the sensor to read the maximum magnetic field at 
that point along the Slinky. How does the magnetic field inside the solenoid seem to vary 
along its length?  

4. Check the magnetic field intensity just outside the solenoid. Is it different from the field inside 
the solenoid?  

 
Figure 2    
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PROCEDURE 
Part I  How is the Magnetic Field in a Solenoid Related to Current? 

For the first part of the experiment you will determine the relationship between the magnetic field 
at the center of a solenoid and the current flowing through the solenoid. Data will be collected in 
Events with Entry mode. Each time you click or tap Keep during data collection, the sensor 
reading will be displayed. You will then enter a value and click or tap Keep Point to complete the 
data point. 

1. Turn off the power supply to stop all current in the solenoid. 

2. Position the magnetic field sensor between the turns of the Slinky near its center, lengthwise. 
Rotate the sensor so that the y-axis label points directly down the long axis of the solenoid in 
the direction that gives the largest positive magnetic field reading. The y-axis label of the 
sensor should still be at the center of the coil, as shown in Figure 2. This will be the position 
for all of the magnetic field measurements for the rest of this part. 

3. Zero the Magnetic Field Sensor to remove readings due to Earth’s magnetic field, any 
magnetism in the metal of the Slinky, or the table. Click or tap the Y Magnetic Field meter and 
choose Zero. 

4. Now you are ready to collect magnetic field data as a function of current. 

a. Turn on the power supply. 
b. Adjust the power supply so that it is set to 0.0 A. 
c. Start data collection. 
d. Hold the sensor still and click or tap Keep. Enter 0.0 as the current and click or tap Keep 

Point to store the data pair. 
e. Increase the current by 0.5 A. Click or tap Keep and enter 0.5 as the current. Click or tap 

Keep Point. 
f. Repeat this process until you collect data for 2.0 A, and then stop data collection. 

5. Answer the Analysis questions for Part I before proceeding to Part II. 

Part II  How is the Magnetic Field in a Solenoid Related to the Spacing of the Turns? 

For the second part of the experiment, you will determine the relationship between the magnetic 
field in the center of a coil and the number of turns of wire per meter of the solenoid. You will 
keep the current constant. Leave the Slinky set up as shown in Figure 1. The magnetic field sensor 
will be oriented as it was before, so that it measures the field down the middle of the solenoid. 
You will change the length of the Slinky from 0.5 to 2.0 m, in order to change the number of turns 
per meter. 

6. Change the event name and the units to create a graph of magnetic field vs. turns per meter. 

a. Click or tap Mode to open Data Collection Settings.  
b. Change the Event Name to turns/m and the Units to m. Leave the rest of the settings as 

they are. 
c. Click or tap Done. 
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7. With the power supply off and the magnetic field sensor in position, click or tap the 
Y Magnetic Field meter and choose Zero to zero the sensor and remove readings due to 
Earth’s magnetic field, any magnetism in the metal of the Slinky, or the table. 

8. Collect the first data point. 

a. Turn on the power supply and adjust the power supply so that it is set to 1.5 A. 
b. Start data collection. 
c. Click or tap Keep and hold the sensor still. Enter the number of turns per meter that you 

calculated, and click or tap Keep Point to store the data pair. 
9. Collect additional data. 

a. Change the length of the Slinky to 1.0 m but keep the number of turns the same. As before, 
re-count the number of turns if necessary, and then calculate the number of turns per 
meter. Record the values in the data table. 

b. Click or tap Keep and hold the sensor still. Enter the number of turns per meter that you 
calculated. Click or tap Keep Point. 

c. Repeat this step to collect data for 1.5 m and 2.0 m. 
d. Stop data collection when you have finished with the last point. 
e. Turn off the power supply. 

10.  Proceed to the Analysis questions for Part II. 

ANALYSIS 
Part I  How is the Magnetic Field in a Solenoid Related to Current? 

1. Count the number of turns of the Slinky and measure its length. If you have any unstretched 
part of the Slinky at the ends, do not count it for either the turns or the length. Calculate the 
number of turns per meter of the stretched portion. Record the length, turns, and the number of 
turns per meter in the data table. 

2. Inspect the graph of magnetic field, B, vs. the current, I, through the solenoid. How is magnetic 
field related to the current through the solenoid? 

3. If the points on your graph of magnetic field vs. current through the coils follow a generally 
linear path, fit a straight line to the data. 

a. Click or tap Graph Tools, , and choose Apply Curve Fit. 
b. Select Linear as the curve fit, and click or tap Apply. The linear-regression statistics are 

displayed. 
c. Record the slope and y-intercept of the regression line in the data table, along with their 

units. 
d. Export, print, or sketch your graph. 

4. Inspect the equation of the best-fit line to the field vs. current data. What are the units of the 
slope? What does the slope measure? 
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Part II  How is the Magnetic Field in a Solenoid Related to the Spacing of the Turns? 

5. How is magnetic field related to the coil density, n, measured in turns/meter of the solenoid? 

6. If the points on your graph of magnetic field vs. number of turns per meter follow a generally 
linear path, fit a straight line to the data. 

a. Click or tap Graph Tools, , and choose Apply Curve Fit. 
b. Select Linear as the curve fit. Click or tap Apply to view the-regression statistics. 
c. Record the slope and y-intercept in the data table, along with their units. 
d. Export, print, or sketch your graph. 

7. From Ampere’s law, it can be shown that the magnetic field, B, inside a long solenoid is 

 
where μ0 is the permeability constant. Are your results consistent with this equation? Explain. 

8. Assuming the equation in the previous question applies for your solenoid, calculate the value 
of μ0 using your graph of B vs. n. You will need to convert the slope to units of T•m from 
mT•m. 

9. Look up the value of μ0, the permeability constant. Compare it to your experimental value. 

10. Was your Slinky positioned along an east-west or north-south axis, or was it on some other 
axis? Does this have any effect on your readings? 

DATA TABLE 
Part I 

Length of solenoid (m)   

Number of turns   

Coil density (m–1)   

  

Magnetic field vs. current 

Slope   

Intercept   
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Part II 
Number of turns Length of solenoid 

(m) 
Coil density 

(m–1) 

      

      

      

      

  

Magnetic field vs. coil density 

Slope   

Intercept   

EXTENSIONS 
1. Carefully measure the magnetic field at the end of the solenoid. How does it compare to the 

value at the center of the solenoid? Does the result make sense? Explain your reasoning. 

2. Study the magnetic field strength inside and around a toroid, a circular-shaped solenoid. 

3. If you have studied calculus, refer to a calculus-based physics text to see how the equation for 
the field of a solenoid can be derived from Ampere’s law. 

4. If you look up the permeability constant, you may find it listed in units of henry/meter. Show 
that these units are the same as tesla-meter/ampere. 

5. Take data on the magnetic field intensity vs. position along the length of the solenoid. Check 
the field intensity at several distances along the axis of the Slinky past the end. Note any 
patterns you see. Plot a graph of magnetic field, B, vs. distance from center.  How does the 
value at the end of the solenoid compare to that at the center? How does the value change as 
you move away from the end of the solenoid? 

6. Insert a steel or iron rod inside the solenoid and see what effect that has on the field intensity. 
Be careful that the rod does not short out with the coils of the Slinky.  

7. Use the graph obtained in Part I to determine the value of μ0. 
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Sound Waves and Beats 
Sound waves consist of a series of air pressure variations. A microphone diaphragm records these 
variations by moving in response to the pressure changes. The diaphragm motion is then 
converted to an electrical signal. Using a microphone, you can explore the properties of common 
sounds. 

The first property you will measure is the period, or the time for one complete cycle of repetition. 
Since period is a time measurement, it is usually written as T. The reciprocal of the period (1/T) is 
called the frequency, f, the number of complete cycles per second. Frequency is measured in hertz 
(Hz). 1 Hz = 1 s–1. 

A second property of sound is the amplitude. As the pressure varies, it goes above and below the 
average pressure in the room. The maximum variation above or below the pressure mid-point is 
called the amplitude. The amplitude of a sound is closely related to its loudness.  

In analyzing your data, you will see how well a sine function model fits the data. The 
displacement of the particles in the medium carrying a periodic wave can be modeled with a 
sinusoidal function. Your textbook may have an expression resembling this one: 

y = A sin (2π f t) 

In the case of sound, a longitudinal wave, y refers to the change in air pressure that makes up the 
wave, A is the amplitude of the wave, and f is the frequency. Time is represented by t, and the sine 
function requires a factor of 2π when evaluated in radians. 

When two sound waves overlap, air pressure variations will combine. For sound waves, this 
combination is additive. We say that sound follows the principle of linear superposition. Beats are 
an example of superposition. Two sounds of nearly the same frequency will create a distinctive 
variation of sound amplitude, which we call beats. 

 

Figure 1    
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OBJECTIVES 
• Measure the frequency and period of sound waves from a keyboard. 
• Measure the amplitude of sound waves from a keyboard. 
• Observe beats between the sounds of two notes from a keyboard. 

MATERIALS 
LabQuest 
LabQuest App 
Vernier Microphone 
electronic keyboard 

PRELIMINARY QUESTIONS 
1. Why are instruments tuned before being played as a group? In what different ways do 

musicians tune their instruments? 

2. Given that sound waves consist of a series of air pressure increases and decreases, what would 
happen if an air pressure increase from one sound wave was located at the same place and time 
as a pressure decrease from another of the same amplitude?  

3. How is it that we can hear all the instruments played by a group of musicians at once? Are 
there conditions under which you cannot hear all instruments? Can two sounds add up to 
create an experience that seems less intense than either sound on its own? 

PROCEDURE 
Part I  Simple Waveforms 

1. Connect the Microphone to LabQuest and choose New from the File menu. Data are collected 
for only 0.03 s in order to be able to display the rapid pressure variations of sound waves. 

2. To center the waveform on zero, it is necessary to zero the Microphone channel. With the 
room quiet, choose Zero from the Sensors menu. 

3. Press and hold a key on the keyboard. Hold the Microphone close to the speaker and start data 
collection. When data collection is complete, a graph is displayed. The data should be 
sinusoidal in form, similar to Figure 1. 

4. Print or make a sketch of your graph. 

5. To examine the data pairs on the displayed graph, tap any data point. Record the times for the 
first and last peaks of the waveform. Record the number of complete cycles that occur between 
your first measured time and the last. Divide the difference, Δt, by the number of cycles to 
determine the period of the note. Record the period in your data table. 

6. Examine the graph again, and record in the data table the maximum and minimum sound 
values for an adjacent peak and trough. 



Sound Waves and Beats 

Physics with Vernier   3 

7. Calculate the amplitude of the wave by taking half of the difference between the maximum 
and minimum y values. Record the values in your data table. 

8. Calculate the frequency of the note in Hz and record it in your data table. 

9. Model your data. 

a. Choose Model from the Analyze menu, then choose Sound Pressure. 
b. Select the equation, Asin(Bx + C) + D. 

10. To see how well the model fits the data, you need to adjust the parameters of the model y = 
Asin(2πft) and plot it with the data. The model, expressed as Y = A * sin(B*X + C) + D, 
contains four parameters; it is more complicated than the textbook model, but the basic 
sinusoidal form is the same. Comparing terms, listing the textbook model’s terms first, the 
amplitude, A, corresponds to the fit term A, and 2π f corresponds to the parameter B. The 
variable X represents the time, t. The new parameters C and D shift the fitted function left-
right and up-down, respectively and may be necessary to obtain a good fit. Only the values of 
parameters A and B are important to this experiment. In particular, the numeric value of B 
allows you to find the frequency f using B = 2π f. 

a. Enter your estimate for the value of A, the amplitude. 
b. Enter your estimate for the value of B (start with 2πf). 
c. Initially use zero for C and D. 
d. LabQuest will plot the data and your model with the current values of A, B, C, and D. 

Adjust each value until you see what each one does and until you have a good match of 
your model to the data. 

e. After optimizing the four values, record the parameters A, B, C, and D in your data table. 
Select OK. 

11. Repeat Steps 3–10 for an adjacent key on the keyboard. 

12.  Answer the Analysis questions for Part I before proceeding to Part II. 

Part II  Beats 

13. Two pure tones with different frequencies sounded at once will create the phenomenon known 
as beats. Sometimes the waves will reinforce one another and other times they will combine to 
a reduced intensity. This happens on a regular basis because of the fixed frequency of each 
tone. To observe beats, simultaneously hold down the two adjacent keys on the keyboard that 
you used earlier and listen for the combined sound. If the beats are slow enough, you should 
be able to hear a variation in intensity. When the beats are too rapid to be audible as intensity 
variations, a single rough-sounding tone is heard. At even greater frequency differences, two 
separate tones may be heard, as well as various difference tones. 

14.  To capture the beats, it is necessary to collect data for a longer period of time. 

a. Tap Meter. 
b. On the Meter screen, tap Rate. Change the data-collection rate to 2500 samples/second and 

the data-collection duration to 0.05 seconds. Select OK. 
15. Start the two tones sounding and start data collection. 
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16.  Note the shape of your waveform graph. You should see a time variation of the sound 
amplitude. The pattern will be complex, with a slower variation of amplitude on top of a more 
rapid variation. Ignoring the more rapid variation and concentrating in the overall pattern, 
count the number of amplitude maxima after the first maximum and record it in the data table. 

17.  Record the times for the first and last amplitude maxima. To do this, tap any data point. 
Divide the difference, Δt, by the number of cycles to determine the period of beats (in 
seconds). Calculate the beat frequency in Hz from the beat period. Record these values in your 
data table. 

ANALYSIS 
Part I  Simple Waveforms 

1. Did your model fit the waveform well? In what ways was the model similar to the data and in 
what ways was it different? 

2. Since the model parameter B corresponds to 2π f (i.e., f = B/(2π)), use your fitted model to 
determine the frequency. Enter the value in your data table. Compare this frequency to the 
frequency calculated earlier. Which would you expect to be more accurate? Why? 

3. Compare the parameter A to the amplitude of the waveform. 

Part II  Beats 

4. How is the beat frequency that you measured related to the two individual frequencies? 
Compare your conclusion with information given in your textbook. 

DATA TABLE 
Part I  Simple Waveforms 

Note Number of 
cycles 

Time of first 
max 
(s) 

Time of last 
max 
(s) 

Δt 
(s) 

Period 
(s) 

Calculated frequency 
(Hz) 

              

              

   

Note Peak 
(V) 

Trough 
(V) 

Amplitude 
(V) 

        

        

 
Part II  Beats 

Number of 
cycles 

Time of first 
max 
(s)  

Time of last 
max  
(s)  

Δt 
(s) 

Beat 
(s) 

Calculated beat 
frequency 

(Hz) 
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EXTENSIONS 
1. There are commercial products available called active noise cancellers, which consist of a set 

of headphones, microphones, and some electronics. Intended for wearing in noisy 
environments where the user must still be able to hear (for example, radio communications), 
the headphones reduce noise far beyond the simple acoustic isolation of the headphones. How 
might such a product work? 

2. The trigonometric identity 

  
is useful in modeling beats. Show how the beat frequency you measured above can be 
predicted using two sinusoidal waves of frequency f1 and f2, whose pressure variations are 
described by sin(2π f1 t) and sin(2π f2 t). 

3. Most of the attention in beats is paid to the overall intensity pattern that we hear. Use the 
analysis tools to determine the frequency of the variation that lies inside the pattern (the one 
inside the envelope). How is this frequency related to the individual frequencies that generated 
the beats?  

4. Examine the pattern you get when you play two adjacent notes on a keyboard. How does this 
change as the two notes played get further and further apart? How does it stay the same? 
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Spectrum of Atomic Hydrogen 
INTRODUCTION 
You have no doubt been exposed many times to the Bohr model of the atom. You may have even 
learned of the connection between this model and bright line spectra emitted by excited gases. In 
this experiment, you will take a closer look at the relationship between the observed wavelengths 
in the hydrogen spectrum and the energies involved when electrons undergo transitions between 
energy levels. 

 
OBJECTIVES 
In this experiment, you will 

• Use a spectrometer to determine the wavelengths of the emission lines in the visible 
spectrum of excited hydrogen gas. 

• Determine the energies of the photons corresponding to each of these wavelengths. 
• Use a modified version of Balmer’s equation to relate the photons’ energies to specific 

transitions between energy levels. 
• Use your data and the values for the electron transitions to determine a value for 

Rydberg’s constant for hydrogen. 
 
 
MATERIALS 

Vernier LabQuest with LabQuest App or VIS-NIR Optical Fiber 
   computer with Logger Pro straight-line filament incandescent  
Red Tide Emissions Spectrometer     bulb and socket 
Vernier Spectrum Power Supply and  replica diffraction grating 
   Hydrogen Tube or   
   conventional hydrogen gas discharge tube  

 
 
PRE-LAB INVESTIGATION 
1. Place the incandescent bulb in the socket, plug it in, and turn on the electrical power to the 

bulb. View the spectrum through the diffraction grating. 

2. Place the hydrogen discharge tube in the power supply socket. Turn on the power and observe 
the bright line spectrum of hydrogen through the diffraction grating. 

Discuss the differences in the spectra from these two sources. The appearance of bright line 
spectra for excited gases created a seemingly insoluble problem for physicists in the late 19th 
century. They could not find a simple way to explain why only certain wavelengths were emitted 
by excited gases. In 1885, Johann Balmer, a Swiss high school mathematics teacher, found an 
empirical equation 

 

λ = 364.56 nm
m2

m2 − 22

 

 
 

 

 
  
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where m was an integer greater than 2, that related the wavelengths of the lines in the visible 
spectrum of hydrogen. Three years later, Johannes Rydberg, a master of spectroscopy, rearranged 
Balmer’s equation and expressed it in a more general form 

 

1
λ

= RH
1
n1

2 −
1
n2

2

 

 
 

 

 
  

where 1/λ is the wavenumber (the reciprocal of the wavelength expressed in m), RH is Rydberg’s 
constant and n1 and n2 are integers such that n1 < n2. This equation led to the discovery of similar 
sets of spectral lines in the ultraviolet (Lyman series) and infrared (Paschen series) in the early part 
of the 20th century. 

Nevertheless, it was not until Niels Bohr proposed his model of 
the hydrogen atom in 1911 that a causal explanation for the 
existence of the bright line spectra emerged. Bohr assumed that 
the electron circled the nucleus in certain well-defined orbits 
corresponding to specific energy states (see Figure 1 at right). In 
his model of the hydrogen atom, the electron can exist only in one 
of these energy states. Ordinarily, the electron exists in its lowest 
energy condition (called the ground state). So long as the electron 
is in a particular energy state, the atom does not emit light energy. 
However, when a hydrogen atom is given enough energy (via an 
inelastic collision or photon absorption), the electron is bumped 
up from its ground state (n = 1) to an excited state (n > 1). When 
the electron drops back to a lower energy state, a photon is 
usually emitted. The lines in the hydrogen spectrum represent various 
transitions made by electrons from higher to lower energy states. 

Further detail on the connection between the Bohr model and bright line spectra can by found by 
observing approximately 5 minutes of a video clip from Episode 3 of Brian Greene’s Fabric of the 
Cosmos,1 which can be viewed from the PBS NOVA web site. 

In this experiment you will analyze the visible bright line spectrum for hydrogen and use a 
variation of the Rydberg equation to relate the energy of the photons associated with each bright 
line to the energy levels in the Bohr model of the atom. 

 
PROCEDURE 
1. If you are using Logger Pro, connect the spectrometer to a USB port on the computer and 

choose New from the File menu. Connect the appropriate optical fiber cable to your 
spectrometer. If you are using LabQuest as a standalone device, connect the spectrometer to 
the USB port on LabQuest and choose New from the File menu.  

                                                
1 http://www.pbs.org/wgbh/nova/physics/fabric-of-cosmos.html#fabric-quantum. The relevant section starts at time 

index 6:38 minutes. 

Figure 1 
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2. Set up the data-collection parameters. 
Using Logger Pro  
a. Choose Change Units ►Spectrometer ►Intensity from the Experiment menu. The 

software will measure the intensity in relative units.  
b. Next, choose Set Up Sensors ►Spectrometer from the Experiment menu. Change the 

data-collection duration to 40 ms. 
Using LabQuest App 
a. On the Meter screen, choose Change Units ► Intensity from the Sensors menu. The 

software will measure the intensity in relative units.  
b. Change the data-collection duration to 40 ms. 

 
3. Turn on the power to the hydrogen spectrum tube and aim the end of the optical fiber at the 

middle of the spectrum tube. Your equipment may have a bracket that will hold the end of the 
optical fiber in position. Note: Hydrogen tubes have a limited lifetime, so do not leave the 
tube on when you are not taking data. 

4. Start data collection. If the peak for the red line (H-α) of the spectrum saturates (flat, wide 
peak at an intensity value of 1.0), move the tip of the optical fiber slightly farther away. If this 
peak is too small, shift the position of the tip so that more light from the discharge tube enters 
it. When the intensity of this peak reaches a value of at least 0.8, stop data collection. You 
need to see at least four distinct peaks to perform this analysis. Depending on your hydrogen 
tube, you may need to collect two runs: one with no peak height above 0.9, and another with 
the two strongest peaks saturated at 1.0 so that you can detect the smaller peaks.  

5. Once you have at least four peaks visible, save your experiment file. Turn off the hydrogen 
discharge tube.  

 
EVALUATION OF DATA  
1. Use the Examine tool to find the maximum intensity for the red line you observed in the  

H-spectrum. Record the wavelength. Repeat this step for the remaining peaks. 

2. Use the value for the speed of light to calculate the frequency of each of these bright lines. 
Keep in mind that your wavelengths were measured in nm. 

3. Using Planck's equation E = hf, calculate the energy of the light emitted for each of the 
observed lines. Planck’s constant is sJ1063.6 34 ⋅×= −h . Record your values in a table like the 
one below: 

Color Wavelength 
(nm) 

Frequency 
(1/s) 

Δ Energy 
(J) 

red    

    

    

    

    

 



Experiment 21 

21 - 4 Advanced Physics with Vernier – Beyond Mechanics 

4. The photon energies you calculated in Step 3 result from differences in the allowed energy 
states of the electron in hydrogen atoms, ∆E = Efinal – Einitial. While they provide a clue to the 
allowed energy states, these values alone are insufficient to determine the actual energy of the 
allowed energy states. We can, however, make use of the fact that ∆E = hf = hc/λ to obtain a 
form of the Rydberg equation that relates the energy of the emitted light to the initial and final 
energy states. 











−×=∆ −

22
18 11 J1018.2

if nn
E  

5. Your task is to determine values of nf and ni that that will give light energies that approximate 
the values that you calculated in Step 3.One way to approach this task is to divide your 
calculated values of ∆E by the constant, 2.18 × 10-18 J, then match this fraction by substituting 
various  

pairs of integers in the 

 

1
n f

2 −
1
ni

2

 

 
  

 

 
   portion of the equation. For example if nf = 1, and ni =2, 

then the expression 

 

1
n f

2 −
1
ni

2

 

 
  

 

 
  =

1
12 −

1
22

 
 
 

 
 
 = 0.75. 

 Record your values and best guesses for nf and ni in a table like the one below. Hint: nf and ni 
for these lines are both less than 8. 

Color ∆E 
(J) 

Ratio 
∆E/constant 

reasonable 
values for 
nf and ni 

red    

    

    

    

    
 
6. Compare your values for nf and ni to those obtained by others in your class. Reach a 

consensus about the values of nf and ni for each of the transitions. 

7. Determine ∆E for a number of transitions from higher energy levels to the ground state. 
Determine the wavelengths of the lines associated with each of these transitions. In what 
region of the electromagnetic spectrum would you expect to find them? Repeat this analysis 
for nf  = 3. 

8. Using the wavelengths you obtained in your analysis of the hydrogen spectrum and the values 
of nf and ni corresponding to the transitions producing these lines, determine an average value 
for the Rydberg constant for hydrogen. The Rydberg equation is in the Pre-Lab Investigation. 
How does your experimental value compare to the accepted value for this constant? 
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EXTENSION 
Visit the Visual Quantum Mechanics web site, http://phys.educ.ksu.edu/vqm/free/h2spec.html, 
and run the simulation for hydrogen spectroscopy. Note that a hydrogen gas discharge tube is lit 
and a spectrum appears at the top. Step-by-step directions are provided. See how closely your 
simulation spectrum matches the observed spectrum for hydrogen. 
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Diffraction 
INTRODUCTION 
As long ago as the 17th century, there were two competing models to describe the nature of light. 
Isaac Newton believed that light was composed of particles, whereas Christopher Huygens 
viewed light as a series of waves. Because Newton was unable to observe the diffraction of light, 
he concluded that it could not be wave-like. Thomas Young’s double-slit experiment in the early 
19th century provided convincing evidence that supported the wave model of light. This is the 
second of two experiments in which you will examine the related phenomena of diffraction and 
interference.  

 
OBJECTIVES 
In this experiment, you will 

• Compare and contrast features of the patterns produced on a screen when light from a 
laser passes through either one or two slits.  

• Discern which features of the pattern arise from the interaction of the light with the single 
slit and which arise from the double slits. 

• Use the principle of superposition to explain how waves from two sources could interfere 
constructively or destructively. 

• Use Huygen’s Principle to construct a diagrammatic explanation of how path length 
differences for waves originating at different points in the slit give rise to the dark fringes 
in a diffraction pattern.  

• From experimental parameters, predict the locations of dark fringes in the pattern. 
• Collect intensity vs. position data to test your predictions. 

 
 
MATERIALS 

Vernier data-collection interface Vernier Optics Expansion Kit 
Logger Pro or LabQuest App Vernier Dynamics Track 
Vernier Diffraction Apparatus Green Diffraction Laser (optional) 
ruler  

 
 
PRE-LAB INVESTIGATION 
Direct exposure on the eye by a beam of laser light should always be avoided with any laser, no 
matter how low the power. If you performed Experiment 19, your instructor may have you skip 
the pre-lab investigation and Part 1 of this experiment. 

1. Attach the laser at one end of the track so that it faces down the length of the track. Connect 
the power supply. Leave the laser off until all parts are in place to avoid accidental reflections.   

2. Set the diffraction slit assembly to a single slit of width, a = 0.08 mm. Attach the assembly to 
the track, with the silver reflective side of the glass plates facing the laser. Position it about 10 
cm from the laser assembly.  
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3. Attach the High Sensitivity Light Sensor and the Linear Position Sensor to the other end of 
the track, with the light sensor facing the slits. 

4. Turn on the laser. Adjust the horizontal laser position to achieve maximum brightness of the 
pattern. Adjust the vertical laser position to center the pattern vertically on the entrance 
aperture of the light sensor. Use this procedure every time you change the slits. 

 
Figure 1  Laser and slit assembly 

 
 
 
 
 
 
 
 
 
 
 

 
Figure 2  Light sensor assembly 

5. Slide the light sensor assembly so that the pattern from the beam falls on the screen to one 
side or the other of the aperture disk (see Figure 2). Observe features of the pattern and 
record your observations in your lab notebook. 

6. Now, set the slit assembly to a double slit in which the slit width, a = 0.08 mm and the slit 
separation, d = 0.25 mm. Align the laser as you did in Step 4. 

7. View the pattern that forms as the laser beam passes through the double slit. Record your 
observations in your lab notebook, then turn off the laser. 

Discuss what features the patterns have in common and the ways they appear to differ. You may 
find it helpful to repeat your observations of the single slit and double slit patterns.  

Study the similar behavior of water waves using a simulation that can be found at the PhET web 
site: http://phet.colorado.edu/en/simulation/wave-interference. The simulation allows you to 
examine the patterns resulting when water waves from a dripping faucet pass through one or two 
slits in a barrier. 

 
PART 1  SINGLE AND DOUBLE SLIT PATTERNS–A CLOSER LOOK 
PROCEDURE 
1. Return to the diffraction apparatus. Examine the pattern obtained when the laser shines 

through the single slit with a = 0.08 mm. Using a ruler, measure the distance between the 
midpoint of the central bright region and the midpoint of the first dark fringe. Repeat this 
measurement for the second dark fringe. Then, measure the width of the central bright region 
from dark fringe center to dark fringe center. 

2. Now, take a closer look at the pattern obtained when the laser shines on the double slit used in 
the Pre-Lab Investigation (a = 0.08 mm, d = 0.25 mm). Using a ruler, measure the distance 
between the middle of the central bright region and the location where the alternating bright 
and dark fringes seem to disappear. Then, measure the width of the central bright region. 
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EVALUATION OF DATA 
1. Compare your measurements for the single- and double-slit patterns. What feature of the 

pattern appears to arise from the single slit? What feature appears to arise from the double 
slit? Compare your findings with those of other groups. 

2. Consider what feature of the single-slit pattern would change if you changed the slit width. 
Test your prediction. 

3. Consider what feature of the double-slit pattern would change if you used the same slit width 
but changed the separation between the slits. Test your prediction. 

 
 
PART 2  DIFFRACTION AND THE SINGLE SLIT PATTERN 
In a typical discussion of how waves from multiple 
slits produce an interference pattern, the slits are 
treated as point sources of light. To understand how 
light passing through a single slit can undergo 
interference, review text or web resources regarding 
Huygens’ principle as it relates to diffraction. Imagine 
that each point along the wave front in a slit acts as if 
it were a separate source of “wavelets” that can interfere 
with one another (see Figure 3).  

To understand why dark fringes occur in the pattern, consider how the path length difference of 
waves from two sources within the slit can result in destructive interference when the waves reach 
the screen. The small angle approximation allows you to substitute y/D for sin θ in your 
calculation of the distance between the middle of the central bright region and the dark fringes to 
either side (see Figure 4). 

 
Figure 4  Diffraction geometry 

Figure 3  Huygens’ principle 
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PROCEDURE 
1. Connect the High Sensitivity Light Sensor and the Linear Position Sensor to the interface and 

start the data-collection program. 

2. Choose the same single slit (a = 0.08 mm) that you used in Part 1. Adjust the alignment of the 
laser on the slit as you did in the Pre-Lab Investigation. 

3. Record the distance, D, from the slit assembly to the light sensor. Record the slit width, a, and 
the wavelength, λ, of the laser.  

4. The optimal combination of light sensor sensitivity and sensor aperture depends on the type of 
laser and the slit configuration. It allows an intensity reading that reveals the detail necessary 
for you to make your measurements. For the red laser and a slit width of 0.08 mm, we suggest 
setting the sensitivity to 1 µW and using an aperture of 0.5 mm. 

5. Move the sensor assembly all the way to the right as viewed from the laser. Zero both sensors.  

6. Start data collection, and then move the sensor assembly stage toward the other side of the 
rail on which it is mounted. Take at least 20 seconds to execute the motion, slowing when the 
sensor is traversing the brightest portions of the pattern. Stop collecting data when the stage 
reaches the end stop. Test that you moved the stage sufficiently smoothly by storing the run 
and collecting another run, moving the stage in the opposite direction.1 The trace of the 
second run should overlay that of the first. 

7. Repeat Steps 6 and 7 with a different slit width. You may find it necessary to change the 
aperture to obtain sufficient detail to complete your evaluation of data. When you are finished 
collecting data, save your experiment file and turn off the laser. 

 
EVALUATION OF DATA 
1. From the values of D, a and λ, calculate the theoretical distance yn, from the central maximum 

to the middle of each of the first three dark fringes to either side for the first slit you used. 

2. Zoom in on the portion of the graph that shows the most useful information. Choose the 
Examine tool from the Analysis menu and move the cursor to your best estimate of the 
position of the peak corresponding to the central maximum. Due to reflection off the front 
surface of the glass in the slit assembly, the intensity may dip sharply at this point (see  
Figure 5). Record this position in your lab notebook. 

                                                
1 If you are using LabPro, do not move the stage between runs or the second run will be shifted horizontally.  
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 Figure 5  Drop in intensity at central maximum 

 
3. Determine the locations of the middle of the first three dark fringes to either side of the peak. 

To do so, position the cursor where you think the intensity has reached a minimum value, then 
use the arrow keys on the keyboard (in Logger Pro) or on LabQuest (in LabQuest App) to 
move the cursor to either side and note how the intensity changes. Record the locations of the 
minima in your notebook. 

4. Determine the distance, yn, from the central maximum to the middle of the first three dark 
fringes on either side. If the distances are not the same on either side, decide how to report the 
best value for yn. 

5. Determine the percent difference between the theoretical and experimental values of these 
distances. 

6. Now measure the peak intensity of the central maximum and first two bright fringes to either 
side. If the baseline of your intensity vs. position graph is not zero, create a new calculated 
column that adjusts the intensities. Because of the abrupt drop in intensity at the peak, you 
will have to estimate its value. Record the intensity values in your notebook. 

7. The theoretical intensities of the bright fringe to either side of the central maximum are given 
by  and . How do your experimental values compare?  

8. Predict how the distances of the dark fringes from the central maximum for the second slit 
width you used will compare to those of the first, then repeat Steps 1–6. 

 
EXTENSION 
1. How does the distance from the central maximum to the first dark fringe vary with slit width? 

If the slit were ten times wider, what would you expect to see on the screen? What model of 
light would best explain your observations? 

2. Suppose you shone a green laser (λ = 532 nm) on the single slit you used in your first trial. 
What effect would this have on the distance from the central maximum to the dark fringes? 
Use a geometric rather than an algebraic explanation for your answer. 

3. Suppose you were able to narrow the slit width to the point that it was less than the 
wavelength of the light you shone on it. Would you see dark fringes in the pattern on the 
screen? Explain. 
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Simple Harmonic Motion 
Kinematics and Dynamics of Simple Harmonic Motion 

 
INTRODUCTION 
When you suspend an object from a spring, the spring will stretch. If you pull on the object, 
stretching the spring some more, and release it, the spring will provide a restoring force that will 
cause the object to oscillate in what is known as simple harmonic motion (SHM). In this 
experiment, you will examine this kind of motion from both kinematic and dynamic perspectives. 

OBJECTIVES 
In this experiment, you will 

• Collect position vs. time data as a weight, hanging from a spring, is set in simple harmonic 
motion (SHM).  

• Determine the best-fit equation for the position vs. time graph of an object undergoing 
SHM.  

• Define the terms amplitude, offset, phase shift, period and angular frequency in the context 
of SHM. 

• Predict characteristics of the corresponding velocity vs. time and acceleration vs. time 
graphs, produce these graphs and determine best-fit equations for them. 

• Relate the net force and acceleration for a system undergoing SHM. 
 

MATERIALS 
Vernier LabQuest ring stand and right angle clamp 
LabQuest App spring 
Vernier Motion Detector mass hanger and standard lab masses  
Vernier Dual-Range Force Sensor wire basket 
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PRE-LAB INVESTIGATION 
Attach a rod to a vertical support rod using a right angle clamp. 
Mount a Dual-Range force sensor to the horizontal rod. Now hang a 
spring from the hook on the sensor and suspend a mass hanger and 
weights from the spring, as shown in Figure 1. Assume that the 
bottom of the hanger is the zero position. Pull on the mass hanger 
slightly and release it. Observe the motion of the hanger. On the axes 
below, sketch a graph of the position of the hanger as a function of 
time. 

 

 

 

  
  

 

Compare your sketch to those of others in the class. 

 
PROCEDURE 
1. Connect the Motion Detector and the Dual Range Force Sensor to LabQuest and start a new 

file in LabQuest App. The default data-collection rate is appropriate; however, shorten the 
duration to 5 seconds.  

2. If your motion detector has a switch, set it to Track. 

3. Place the motion detector on the floor beneath the mass hanger. Place the wire basket over the 
motion detector to protect it 

4. Make sure the hanger is motionless, then zero both the force sensor and the motion detector. 

5. Lift the hanger and weights about ten centimeters, then release. When the mass hanger is 
oscillating smoothly, begin collecting data. 

6. If the position-time graph appears to be a smooth curve, store this run. If not, repeat until you 
obtain a smooth curve. 

7. Perform a second trial, except this time, make the initial displacement of the mass hanger 
smaller than what you did for your first trial. If the position-time graph is not smooth, repeat 
until you obtain a smooth curve.  

Figure 1 



 Simple Harmonic Motion 

Advanced Physics with Vernier - Mechanics 3  

EVALUATION OF DATA 
Part 1  Exploration of SHM 
On the Graph tab choose to view only the position-time graph for your first run. Since your 
position-time data appears sinusoidal, you will model a sine function 

 

y = Asin(Bt + C) + D to the 
data by choosing values of the parameters that will enable you to manually fit a curve to your 
position-time data. The following steps will help you determine the appropriate values of these 
parameters. You are likely to find that your first effort will produce a model equation that 
approximates your position-time data. Repeating this process will enable you to refine your 
equation to more closely match the data. Before you begin, tap on the position-time graph to 
determine the maximum and minimum values of position during your run.  

1. Compare the position-time graphs you obtained with the one you sketched in the Pre-Lab 
Investigation. In what ways are the graphs similar? In what ways do they differ?  

2. Choose Model from the Analyze menu, then select 

 

y = Asin(Bx + C) + D from the drop-down 
Equation list; keep in mind that the x variable stands for time. The test plot displayed is a 
much larger version of your sinusoidal y-t data. In the following steps you will adjust the 
values of the parameters. Do not tap OK until directed to do so. 

3. Because you zeroed the motion detector before you began collecting data, your position-time 
data should be centered about the time axis. Use the down arrow to reduce the value of D to 
0. This should make the test plot symmetrical with respect to the time axis. 

4. Next, reduce the A parameter to the value you observed for the maximum value of your 
position-time graph. What aspect of the y-t graph does A appear to describe? Tap Cancel, then 
test your conclusion by performing Steps 2–4 on your second run. Tap Cancel, return to your 
first run, and adjust D and A as before. Do not yet tap OK. The name given to the A 
parameter is amplitude.  

5. Unless you managed to begin collecting data at the instant the oscillating mass hanger was 
rising through the 0 position, your position-time graph is likely to be shifted somewhat left or 
right from the standard position of a graph of 

 

y = sinθ . Try changing the value of the C 
parameter to see what effect this has on the position of the sine curve in the test graph 
window. Adjust C until the test plot appears to have the same initial y-value as your data.  

6. Since the argument of a sine function must be an angle, the expression Bt + C must have units 
of an angle measure. The values LabQuest App uses for the C parameter are given in radians. 
Now, take a closer look at B; its units must be radians/second in order for the sine function to 
operate on the argument (Bt + C). The B parameter, known as angular frequency, ω, is a 
measure of how frequently the hanger and mass oscillate. 

7. Gradually increase the value of B and note what happens to the time required to complete one 
cycle– the period of oscillation. Continue increasing B until the test plot best matches your  
y-t data. You may also need to fine tune your choice for C. Tap OK. Be sure to record the 
values of the parameters to the sine fit to your position-time data.  

8. Use the Delta function from the Analyze menu and drag across the graph from one maximum 
to the next to determine the period, T, of oscillation. Given that one cycle is 2π radians, divide 
2π by T and compare this value to B. Express angular frequency, ω, in terms of T. Make sure 
that you discuss the physical significance of this parameter before moving on to Part 2 of the 
evaluation. At this point you may turn off the Model function for the position-time graph. 
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Part 2  Rates of change 
In earlier experiments you investigated the relationship between position-time and velocity-time 
graphs for linear kinematics. In this part you will continue this investigation for the more complex 
motion of an oscillating body.  

9. From the Graph menu, choose to show both graphs. Change the vertical axis of Graph 1 to 
velocity. Note the position of the mass hanger when its speed is at a maximum value and again 
when its speed is zero. 

 10. Turn on Tangent (found in the Analyze menu) and tap the position-time (y-t) graph at several 
places. Compare the slope of the tangent to any point on the y-t graph to the value of the 
velocity on the v-t graph. Write a statement describing the relationship between these 
quantities, then turn off Tangent. 

 11. The instantaneous rate of change of a function is known as its derivative. Since cosine is the 

derivative of the sine (that is, θ
θ

θ cos)(sin
=

d
d ), and velocity is the derivative of position, it 

seems reasonable to use the cosine to fit the velocity-time data. Choose to Model the v-t 
graph, then select the cosine function. Adjust the D parameter to 0 as before and reduce the A 
parameter to match the amplitude. Then, adjust the B and C parameters to the values used in 
the sine fit to the y-t data; this makes the arguments of the two functions the same.  

 12. Tap OK. From what you know about the chain rule, determine the value of the coefficient of 
the cosine function when you take the derivative of your sine fit to the y-t graph. Compare this 
to the A parameter you used to fit the cosine to the v-t graph. 

 13. Now change the vertical axis label of the position-time graph to acceleration and choose 
Autoscale Once to make sure that you can see the data points. Examine the v-t and a-t graphs 
to note how the velocity and acceleration of the hanger change at various times in a given 
cycle.  

 14. From what you know about velocity and acceleration, use the Model function to fit an 
appropriate function to the acceleration-time graph. Make sure that you keep the argument of 
the function the same as in the y-t and v-t graphs. What change do you have to make to 
parameter A in order to match the test plot to your a-t graph? How does A compare to the 
value of the coefficient you obtain when you find the derivative of the function used to fit the 
v-t graph? Tap OK to return to the Graph tab. 

Part 3  The role of force 
 15. On your v-t graph replace velocity with force as your vertical axis label. Change the vertical 

axis label of the a-t graph to position. Since you zeroed the force sensor before you began 
collecting data, this column in the data table ought to be labeled net force. Note how the net 
force acting on the mass hanger varies as its position changes from maximum to minimum. 
Explain why the net force responsible for SHM is called a restoring force. 

 16. Change the vertical axis of the position-time graph back to acceleration (you may need to 
Autoscale to view the data points). Describe how the acceleration of the mass hanger varies as 
the net force varies through each cycle of SHM. Would you expect Newton’s second law to 
apply to this type of motion? 
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 17. To test whether the net force is proportional to the acceleration in this kind of motion, choose 
to view just the force-time graph. Tap the y-axis label and select Acceleration. Turn off 
Connect Points in the Graph Options dialog box. From the Analyze menu, choose Curve Fit 
and perform a linear fit to the data. Relate the slope to any system parameter that was held 
constant. 

 18. Consider the components of the oscillating system when you try to explain any discrepancy 
between the value of the slope reported by LabQuest App and the constant of proportionality 
you may have expected. 

 

EXTENSION 
You should have noticed that the B parameter to the sine fit to your y-t data for each of your runs 
was the same. In this activity you will explore aspects of the physical system on which the angular 
frequency ω, depends. 

As you saw in Part 3, Hooke’s law describes the relationship between the restoring force and the 
position of the mass hanger, y. Substitution of this expression for force into Newton’s second law 
yields 

 

−k y = m a . As you saw in Part 2, the acceleration is the second derivative of position with 
respect to time. The previous equation can be written as: 

2

2

dt
ydmyk =−  

This is a 2nd order differential equation. The solution to such an equation is a function. In this 
experiment, you have found a function for y(t) that neatly describes the motion of the system. 
Substitution of this function in the equation above, rearranging and canceling like terms should 
enable you to derive an equation for ω in terms of k and m. 

When you have done so, predict how you could change the angular frequency of the SHM by 
some simple factor (like doubling or halving). Go back to your experimental setup and test your 
prediction. 

Consider any other factors that may have an effect on the value you obtain for B. After your 
discussion, make the necessary adjustment to the hanging mass to test your prediction and 
perform another run. 


	00 2019 NSTA Physics Smorgasbord Cover Sheet
	01 Alpha Beta Gamma
	02 Distance and Radiation
	03 Conservation of Angular Momentum
	04 Centripetal Acceleration
	Centripetal Acceleration
	Introduction
	OBJECTIVES
	In this experiment, you will
	MATERIALS
	PRE-LAB INVESTIGATION
	Part 1 – Force vs. velocity
	PROCEDURE
	Figure 1
	EVALUATION OF DATA
	Part 2 – Investigating the effect of mass and radius
	procedure
	EVALUATION OF DATA
	Extension

	05 Capacitors
	Capacitors

	06 RLC Circuits
	07 Magnetic Field in Slinky
	The Magnetic Field in a Slinky

	08 Sound Waves and Beats
	Sound Waves and Beats

	09 Spectrum of Atomic Hydrogen
	10 Diffraction
	11 SHM Kinematics
	Blank Page
	Blank Page
	Blank Page
	Blank Page
	Blank Page
	Blank Page

